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Introduction 
 
BLA uses Property Sales Reports (the LA-3) to conduct assessment/sales ratio studies. Beginning with FY 2010, 
the Bureau of Local Assessment is requiring annual sales submissions by all communities; these sales will be used 
to automatically generate sales statistics for certification, interim year adjustment (the LA-15) and the EQV process. 
In order to conduct an accurate study, data needs to be submitted on all sales over $1,000.  
 
The Bureau of Local Assessment publishes the specific format required for sales data submission in its 
Classification Codes and Sales booklet. This booklet was last revised in late June, 2009, and can be downloaded, 
printed or viewed on our web site: 
 

www.mass.gov/dor/docs/dls/bla/classificationcodebook.pdf 
 
Communities using computer-assisted mass appraisal (CAMA) systems usually have the ability to produce a data 
file consisting of real estate sales occurring within a specified timeframe. This file can be used as the basis of an 
electronic submission; the DLS Gateway now contains an LA-3 module that allows uploading, verifying and 
certifying of sales data. This user guide will give you the instructions necessary to take a data file from any CAMA 
system and turn it into an LA-3 submission.  
 
Submitting sales information electronically benefits municipal officials, real estate professionals and the general 
public by making sales data readily available online.  Sales data contained in the Gateway database can be 
searched, viewed and even exported to Microsoft Excel. 
 
Another benefit for municipal assessors is the ability to produce an LA-15 Interim Adjustment Report for use in the 
tax rate setting process, simply by uploading sales through Gateway. The LA-15 is generated automatically, based 
on sales submissions and other data stored in Gateway. Starting this fiscal year (2010) it is no longer necessary to 
enter interim adjustment information manually; the form is generated by Gateway itself, and only requires the 
review and signatures of local assessors. 
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Available Tools 
 
The Division of Local Services provides a few tools to promote easier submission of sales data: 
 
DLS Gateway’s LA-3 module: Sales data can be submitted to BLA using DLS Gateway, which computes 
statistics for BLA’s review automatically. Gateway also uses the sales statistics to create the LA-15 (Interim 
Adjustment form) necessary for tax rate approval in non-certification years. Sales submissions can be searched, 
adjusted, verified and then officially submitted by assessors from any computer with Internet access, 24/7. 
 
BLA’s LA-3 Format/Character Cleaner template:  BLA has a very useful Excel workbook available for download 
on the Gateway LA-3 Bulk Upload page. This workbook uses macros (embedded programming) to check sales 
data for proper formatting. It also checks for the existence of special characters that will be rejected by the DOR 
firewall, which will cause the upload process to fail. This is the URL for downloading the BLA LA-3 
Format/Character Cleaner: 
http://www.mass.gov/Ador/docs/dls/ghelp/LA3_format_with_character_cleaner.xls 
 
BLA’s Property Type Classification Code Booklet:  This booklet contains all current property use codes, as well 
as the current LA-3 specifications and non arm’s length (NAL) codes. It was updated the last week of June, 2009 
and is available on BLA’s Certification page as well as their General Info page. Here is a link to that document: 
www.mass.gov/Ador/docs/dls/bla/classificationcodebook.pdf 
 
Questions about the LA-3 submission process, NAL codes, the Property Type Classification Booklet or other 
assessment-related issues can be referred to the Bureau of Local Assessment; contact your BLA advisor directly, 
or send an email to the main BLA mail account: BLADATA@DOR.STATE.MA.US. 
 

BLA Advisor Phone number/extension Email 
Sandra Bruso 413-452-3983 bruso@dor.state.ma.us 
Jeff Reynolds 413-452-3981 reynoldsje@dor.state.ma.us 
Jen Silvia 508-792-7300 x22319 silviaj@dor.state.ma.us 
Joe Barbieri                        413-452-3982                                      barbierij@dor.state.ma.us 
Scott Santangelo 508-792-7300 x22325 santangelos@dor.state.ma.us 
Grace Sandell 617-626-2322 sandellg@dor.state.ma.us 
Steve Sullivan 617-626-2393 sullivanst@dor.state.ma.us 
Tom Dawley 617-626-2389 dawleyt@dor.state.ma.us 
Walter Sandoval-Dusza 617-626-4087 dusazw@dor.state.ma.us 
Jack Lyons 617-626-2368 lyonsj@dor.state.ma.us 

 
Questions about DLS Gateway itself, including how to obtain an account, how to login or how to submit data can 
be answered by calling DLS IT Support at 617-626-2350, or by emailing DLSITGroup@dor.state.ma.us. 
 
Gateway Help Library:  A collection of Gateway Help documents can be found in the Information Technology 
section of the DLS web site. Click Information Technology on the DLS Main Page, then click the link labeled 
Gateway Help System.  
 
The Gateway-MASSGIS Connection:  MASSGIS now uses sales information from Gateway to pinpoint sale 

locations on local maps. Anyone can locate sales by city/town, property type, sale date, sale price, or a combination 
of factors. BLA’s General Info page has a link to MASSGIS’s sales search page: 
http://maps.massgis.state.ma.us:8080/LA3/pages/main.jsp 
 

Nathaniel Cramer               617-626-3937                                      cramern@dor.state.ma.us 
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FY 2010 Non-Arms Length (NAL) Codes – Revised June 2009 
 
With communities now submitting the LA-3 online, the Bureau of Local Assessment recently expanded its list of 
non-arms length codes in order to minimize the number of reported “N” coded sales. The new codes evolved in 
response to the most frequent “N” coded explanations received by BLA, and should allow communities submitting 
the LA-3 to use code “N” less often. The new codes are T, U and V, with code H being expanded to include estate 
sales. This is the list of allowable NAL codes for FY 2010: 
 
A. Sale between members of the same family  
B. An intra-corporation sale, e.g. between a corporation and its stockholder, subsidiary, affiliate or another 
corporation whose stock is in the same ownership  
C. Sale of commercial or industrial real property which includes machinery, equipment, inventories or “good will”  
D. Sale of property substantially changed after the assessment date but before the sale, e.g., sale of a property on 
which a building was added after the assessment date, or sale of a property which was demolished partially 
destroyed, subject to fire, flood, or remodeled after the assessment date  
E. Sale to / from federal, state, or local government  
F. Transfer of convenience, e.g., correcting defects in a title, a transfer by a husband either through a third party or 
himself and his wife to create a tenancy by the entirety, etc.  
G. Sale of only a portion of the assessed unit, e.g., a parcel sold from a larger tract and the assessment is for the 
larger tract, or a portion is in another municipality  
H. Sale resulting from a court order, e.g., a divorce settlement, estate sale (expanded category) 
I. Sale in proceedings of bankruptcy  
J. Sale of an undivided interest  
K. Sale to / from an educational, charitable, or religious organization  
L. Repossession or sale of a foreclosed property  
M. Sale of property, the value of which has been materially influenced by zoning changes not reflected in current 
assessments  
N. Other, when a non-arm’s length sale does not fall into any other category, this code is used, accompanied by a 
written explanation  
*O. Sale of property with a substantial physical change after the sale. An example is a house which has been 
remodeled after the sale, before the assessment date  
*P. Sale of property with a change in use after the sale  
Q. Sale of property which includes both a trade of property and cash for the property conveyed  
R. Sale of property which has been sold more than once in the same year. Only the last sale is used for analysis 
purposes.  
S. Sale of a foreclosed property. May be arm’s length in special circumstances (must be supported by detailed 
documentation)  
T. Property sold to an abutter (NEW CODE) 
U. Private sale not put on the market  (NEW CODE) 
V. Sale of multiple parcels; code replaces the “G” code, which will now be reserved exclusively for sales which 
involve property located beyond the community’s boundaries.   (NEW CODE) 
W. Sale affected by deed restriction, e.g., 40B housing; also appropriate for parcels under Chapter 40B or Chapters 
61, 61A or 61B  (NEW CODE) 
 
*Codes used for reporting sales for certification review analysis, when the sale prices are compared to the 
proposed values. The codes would also be used in the EQV program. 
 
 
Note: Codes other than the above will not be uploaded.  The system will reject a code like QS.  The system 
will convert code with a number following the letter, such as N3, to its single letter value, e.g. N. 
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Overview: Submitting LA-3 Sales Data Electronically via DLS Gateway 
 
This is the process, in general terms, for submitting LA-3 sales data electronically: 
 

1. Download and save a copy of BLA’s LA-3 Cleaner Template Excel file. 
2. Create the LA-3 sales data file using your CAMA system. 
3. Open the BLA’s Excel LA-3 Cleaner template file. 
4. Open your LA-3 sales data file in another Excel window. 
5. Copy the sales data (data only – no column headers) from the data file window into the BLA LA-3 Cleaner 

Template window. 
6. Click the Clean For Upload button in the Cleaner Template to run BLA’s data checking macros. 
7. Visually scan the data in the Cleaner window:  fill in anything that’s missing, and delete all sales of less 

than $1000. 
8. Log into DLS Gateway and go to the LA-3 Bulk Upload page. Select the reason for uploading: Certification, 

EQV or Interim Year Adjustment.  (See special instructions for Interim Year Adjustment below.) 
9. Copy the data only – not the headers – and paste it into the Bulk Upload window. 
10. Click the Process Bulk Data button and read the completion message carefully; it will indicate the number 

of records uploaded successfully as well as unsuccessfully. 
11. Click the Save button to save the uploaded data to Gateway. 
12. If not all data loaded successfully, it can be fixed by using one or more of these methods: 

a. Edit or delete single records using the Search/Update/Delete option 
b. Use the Single Record Upload option to add individual sales 
c. Fix the errors in the Excel Cleaner Template file and use the Bulk Upload option to  upload all data 

again (it will replace all existing data) 
13. When all data is completely and correctly loaded and coding and statistics are checked for accuracy, use 

the LA-3 Sign and Submit page to submit your data to BLA for review. 
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Tips for Preparing Your Sales Data for Submission 
 
Use BLA’s Cleaner Template. It will screen out characters that won’t make 
it past the DOR firewall,  and will reformat columns of data that might be in 
the wrong format. To obtain a copy of the Cleaner template: 
 

• Log into DLS Gateway 
• Select the LA-3 module, then the Bulk Upload option.  
• Click the link to download BLA’s LA-3 format and character cleaner 

Excel template (if it opens automatically, save it to your computer or 
server.) 

 
The BLA Cleaner template contains macros. You may need to click 

Enable Macros if your Excel security settings warn you about the file; if you do not see the blue Clean for Upload 
button in the template, macros may be disabled on your system and the file will not work correctly. Click Tools > 
Macro > Security to check your current macro security level; it must be no higher than Medium for the template to 
work. 
 
Excel sometimes interprets data in a CSV file incorrectly. When you open your sales data file in Excel, does 
some of the data look strange? Did Excel strip off the leading zeros from the state use codes and zip codes? Do 
your parcel IDs appear in scientific notation? When Excel opens a text file, it takes a guess as to the type of data in 
each column. Sometimes it guesses correctly, and sometimes it doesn’t.  

• If your sales data file has a CSV extension, Excel will simply open it and you’ll see the data. It will guess 
the data formats, and data may or may not be displayed correctly. 

• If your sales data file has a TXT extension, Excel will start the Text Import Wizard, which allows greater 
control over how Excel imports data.  Hint: if your CAMA system produces a data file with a CSV extension, 
renaming it with a TXT extension will force Excel to use the Text Import Wizard. 

• To get the Text Import Wizard to run, start Excel first, then use File > Open to find your sales data file. 
Don’t use “Open With – Excel” in Windows Explorer; make sure you’re in Excel first, then open the text file. 

 
Have both Excel files open simultaneously (BLA’s cleaner template and your LA-3 sales file) so you can easily 
copy from one workbook and paste to the other. 
 
To quickly select all data in your LA-3 sales data file: use Ctrl-End (press both keys together) to move the 
cursor to the last cell in the spreadsheet that contains data, then use Shift-Ctrl-Home (all three keys together) to 
return the cursor to the first cell while selecting everything in between. Your entire data range should be selected. 
 
Ways to Copy selected data:  

• Click Edit > Copy on the menu bar 
• Right-click anywhere inside the highlighted data and select Copy from the pop-up menu 
• Press Ctrl-C. 

 
Ways to Paste selected data:  

• Click Edit > Paste on the menu bar 
• Position the cursor where the data should go, right-click, and select Paste from the pop-up menu 
• Press Ctrl-V.  

 
Remove all sales of less than $1000. BLA does not want you to submit sales under $1000, so screen them out of 
your data file prior to uploading to Gateway. 
 
 
Make sure there is no missing data - you cannot have blank cells in columns C (parcel ID), D (buyer/grantee), E 
(seller/grantor), F (street number), K (sale price), L (current assessed value) or M (proposed assessed value.)  
Numeric cells (columns F,K,L and M) must contain a number equal to or greater than zero. 
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Your data cannot contain any of the following characters: ~ ` ^ * = { } | \ < > [ ] "    
These characters are seen by the DOR firewall (and most other firewalls) as potentially dangerous, because they 
often appear in malicious code. The BLA Cleaner Template will screen out these characters automatically. 
 
A couple of steps remain after adding any missing data and removing illegal characters: 

• Modify entries in Column I, Property Type ID (state use code) so the code reflects the use at the time of 
assessment, not at the time of the sale. 

• Add the Assessment/Sale Ratio (ASR) column: Under the header AS_Ratio, add the ASR formula to the 
first blank cell in column N, then copy it down to fill the column. The formula should be Column M 
(Proposed Value) divided by Column K (Sale Price.) 

• Column O, Outlier, should remain blank—this column is filled by DOR. 
• Column P, Time Trend, should either be completely blank or completely filled; if you are not using a time 

trending adjustment, leave the column blank. 
 
Remember to click SAVE after uploading! Upload your data, then click the Save button. This step saves the data 
to the DLS web server, where it can be searched, viewed, edited, deleted, or replaced until you’re ready to officially 
submit it to BLA. 
 
Saving is not the same as submitting. Data that has been saved but not submitted is in a working state, and BLA 
will not consider it final until you tell them it’s final. Remember to submit your data when you’re ready for BLA to 
review it, by going to the Sign and Submit page. Check the signature box and click the Submit button when you’re 
ready for BLA to review your sales data. 
 

 
 
 
 

Special Instructions for Interim Year Adjustment bulk uploads: Prior Year 
NAL and State Use Codes 
 
The interim year adjustment upload format is ordinarily the same as the format used for Certification, i.e. the 
standard LA3 format noted above in Step 1. For larger communities an additional upload option exists that is 
described below.   Note that when the upload is complete and saved, the format as seen on Gateway in the Search 
/Update/Delete screen now includes additional columns 

– The standard LA3 file has columns for the NAL and state use code for the current year.  Interim Year 
Adjustment adds columns for the NAL and state use codes for the previous year.  For most 
communities, the previous NAL code is automatically filled (when Save is clicked after Bulk Upload 
processing) with the NAL code used for the current assessed value. This will be accurate in most 
cases but will need review since there may be instances where the NAL code is different from one 
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year to the next. An example would be a sale that should be un-coded in one year and coded P in 
another year. Review the file and individually edit codes as appropriate.   

– But what if you have hundreds of sales and your assessment system is capable of creating a file with 
accurate prior year codes?  You need not individually edit these after upload.  When the Interim Year 
Adjustment process is selected for bulk upload, a checkbox entitled Upload Prior Year Use 
Code and NAL Codes appears. Checking this box tells the system you will be supplying two 
additional columns PRIOR YR USE CODE and PRIOR YR NAL CODE immediately after 
STREET NAME and before CURRENT YR USE CODE. A separate cleanup program is triggered for 
this file format. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

– Similarly, the columns for the assessment sales ratio for the current year and for the current year 
based on time trended sales will be augmented by a column for the assessment sales ratio for the 
previous year.  Pleases NOTE that if time trended sales are used: Statistics shown on the LA15 
default to represent NON time trended sales. If you wish to view the statistics utilizing time trending 
you can click on the button, on the LA15, for time trended sales and a pdf file appears with those 
statistics. 

 
It is important to note that the statistics for the LA15 are calculated directly from the LA3 for Interim Year data. This 
makes the issue of coding very important and dictates that you only SAVE the LA3 data and not SUBMIT the LA3 
data until all LA3 issues are settled. After saving the LA3 you can look at the LA15 and see the resulting statistics. 
After all issues are resolved, the LA3 can be submitted. Once submitted, the data are locked, preventing changes. 
If you have submitted the LA3 but wish to make additional changes you must contact the Bureau of Local 
Assessment so that the LA3 can be unlocked for your revisions. This can be done via e-mail at 
BLADATA@DOR.STATE.MA.US  or by calling (617) 626-2300. 
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Searching for Sales Using DLS Gateway 

 

https://dlsgateway.dor.state.ma.us/gateway/Public/WebForms/LA3/LA3Search.aspx 
 
The bottom-most link on the Gateway Login page will take you to DLS’s LA3 Parcel Search feature. You do not 
have to be a registered Gateway user to access the LA3 Parcel Search – anyone can use it. 
 
To search for sales using the LA3 Parcel Search feature: 

• Select one or more Jurisdictions (cities/towns) from the list. Press the Ctrl key while clicking a jurisdiction 
name to select more than one name, then click the > button to send the name(s) to the Selected 
Jurisdiction(s) box. To select ALL jurisdictions, click the >> button. 

• Select one or more state use codes from the Available Prop(erty) Types list using the same method 
described above. 

• If you wish to restrict the search to only valid sales or only invalid sales, click the appropriate radio button. 
Both valid and invalid sales will be returned by default. 

• Enter starting and ending sale dates using the format MM/DD/YYYY to search for sales occurring between 
two dates. You must enter a date in Sale Date To if you enter a date in Sale Date From. 

• Enter minimum and maximum sale price to search for sales within a specific price range. You must enter 
an amount in Sale Price To if you enter an amount in Sale Price From. 

• Enter a Buyer Name to find sales information relative to a specific name. 
• Enter a Seller Name to find sales information relative to a specific name. 
• Enter a Street Name to find sales on a specific street. All sales beginning with the name entered will be 

displayed; for example, if you enter “HILL” in Street Name, you will see sales on Hill Rd, Hill Ave, Hillcrest, 
Hillside Ave, and so on.  

• 50 sales per page are displayed by default. Select 100, 200 or 300 from the list to see more sales per 
page.  More sales per page will require significantly longer processing time. 

• Sales can be sorted by any column simply by clicking a column header. The current sort order will be 
displayed above the data; click the Reset Sort button to remove the sort. 

• Currently displayed sales can be sent to Excel by clicking the Export to Excel button at the bottom of the 
screen. 




